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(813-251-7591).

Assistive technology has truly changed my life. The list of the things
that I could not do would be much longer than the list of the things that
I can. A little box, called a string switch enables me to access another
box, called a Ke:nx, which in turn accesses my computer. What the
Ke:nx does is put all of the functions of the keyboard and mouse onto
the monitor. With the string switch I access the menu by scanning at a
rate that can be set to a speed that one is comfortable with. Most people
think because you access a computer differently, the computer is
special. No, I use a
Macintosh 3400
PowerBook—nice, but
not “special.”

With my Mac and
assistive technology, I
can write a column for
my school newspaper,
get on the Internet,
create 3D artwork with
Bryce II, create my
own web page, work
on my photography
(continued on page 2)
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"If all my possessions were taken from me
with one exception, I would choose to keep

the power of communication, for by it I
would soon regain all the rest.”

Daniel Webster

(continued from page 1)
with Adobe Photoshop and last but not least, do my
homework! The list of things that I can do is
practically limitless, there just doesn’t seem to be
enough hours in the day!

It took a long time for me to receive assistive
technology—but once I did, it was well worth it. The
advice that I would give others in school who need
this technology, would be to visit FAAST to see what
types of assistive technology are available and
determine what would benefit your needs.

Locating the right equipment might be a lot easier
than receiving it. If you are in school, you should
request an evaluation and make sure to get assistive
technology onto your IEP (Individual Educational
Plan). The benefits of being able to access a computer
has resulted in my being fully included in all
“regular ed” classes at Plant High School. I will also
be able to take my HSCT (High School Competency
Test) on my computer, once the State of Florida is
able to create this format. That is another thing that
anyone in school should be aware of—you need to
list “how” you can take your tests on your IEP.

Assistive technology has been a very necessary
addition to my life, one that has turned my disability
into ability!

Michael Phillips
Junior, Plant High School
Web page address:
http://palpatine31.home.mindspring.com
E-mail address: palpatine31@mindspring.com
Age: 16

Michael Phillips attends Plant High School in
Hillsborough County and is enrolled in its gifted
program. Michael’s underlying medical diagnosis is
Werdnig-Hoffman disease or spinal muscular
atrophy. Due to his illness, the signals to his muscles
are weak and, as a result, he is unable to walk.

This has not stopped Michael. Over the course of the
last three years, Mike has photographed Dan Rather,
David Letterman, Siegfried and Roy, soap opera
stars, Hollywood celebrities, the Pittsburgh Steelers
(the day before they played in the Super Bowl!), the
Tampa Bay Lightning, a number of New York
Yankees, the USA Women’s Soccer team at the
Olympics in Atlanta, Vice President Al Gore and
Tipper Gore at the Vice Presidential Debate in St.
Petersburg, and President Bill Clinton two days
before the election! Michael has traversed the
country to photograph these people and all the while
maintaining a 4.123 grade point average.

A few months ago, Mike was awarded a Chair
Scholarship that will enable him to attend any public
college or university within the state of Florida. He is
an avid “Macintosher” computer user and accesses
his computer and camera through the use of
assistive technology. He is assisted at school by an
aide. Mike resides with his Mom, his brother Brian
and two dogs, Winston and George.

Mike is also a member of the FAAST Council of 100,
consumers with disabilities across the state who
provide direct input and feedback on consumer
needs and program effectiveness.



Ridgeview Elementary (Orange Park, FL) is a K-6th
grade school of approximately 1000 students. It is the
county’s site for all elementary age students who are
in the profoundly mentally handicapped program.
Five years ago, we converted to an engineered
learning environment for the benefit of the “higher”
functioning students. As class
makeup changed, the techniques
were used with a wider and wider
variety of students—with great
success at every level. Due to
amazing progress, students moved
to other classes. The majority of new
students had no prior environmental
stimulation. We exposed each new
student to some language and
literacy training with improvements
occurring in these students within
one week! At the same time, the
engineered environment continued
to positively affect students who
had been in the program for just a
few months. 

We began the process by labeling every item
in the classroom with a printed word and by
covering the entire room with opportunities for
communication. Large Yes/No symbols were
attached with velcro to every conceivable surface. As
we grew into the process, we added frequently used
overlays and other choice-making boards. Activity
choices were posted on photographs. Later, printed
words were added to picture choices and pictures
were eventually dropped from the boards. We had
seen extensive food choice displays in other
engineered settings (both classroom and cafeteria),
but we were having a tough time finding an
adequate supply of “good” pictures. 

One day we tried using color-coded word cards
(without symbols) during lunch. We color-coded the
word choices for food groups for discrimination
purposes to see if it would work. On the first day, we
had “chicken” (red), “green beans” (green), “rolls”
(brown), “peaches” (orange), and “milk” (black—all
drinks are labeled in black). The process was
initiated with the most-likely-to-succeed student, P.J.
He was told what each food card meant as it was

placed on a non-skid mat within his pointing range.
His lunch was placed in view. Whenever P.J. pointed
to a food card, he was given a small portion of the
food item. During breakfast the next day, he was
shown the food cards for “waffle,” “milk,” and
“juice.” He got up and found the food cards from

the day before and brought
“peaches” over to us. He was
told that this food card was from
yesterday and that today’s
choices included “waffles,”
“milk,” and “juice.” He
continued to point to “peaches.”
We took the card and threw it
into the trash to show him that
the “peaches” were gone. He,
however, found the colored
makers, got out the orange one,
and brought it to us. We ran to
the cafeteria to ask for some
peaches! What an amazing
accomplishment for P.J.! Other
students in our classes have since
used the system at varying levels

from pictures to words. Our theory is that for
students with profound mental handicaps

looking at pictures is an act of decoding just like
sight word reading (because they don’t understand
what the picture or word represents). We feel that for
some students, it is more difficult for them to learn
one system and then learn another. Therefore, if an
advanced system is usable, go for it! Using words is
so much more adaptable to any setting. We have a
board of laminated 3x5 color-coded word cards for
meals and for all other choice-making boards (e.g.,
activities, positioning equipment, etc.). The students
in two of our classes use these color-coded word
cards as their primary communication strategy.

If you are a teacher of students with profound
mental handicaps, you may find this a little hard to
believe, as I did when I first started. As the make-up
of my class changed, word cards were introduced to
a wider variety of students. A student came to my
class from another state. She is non-verbal, visually-
impaired, and in a wheelchair. Her mother said that
all she basically did at her old school was to sit in
(continued on page 5)
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Spotlight On: Ridgeview Elementary School
by Holly Cromer

P.J. Schellinger
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This is the second article in a series about technology and
strategies presented at Closing the Gap. The next Gap Capsules
will feature “Worksite Accommodations for People who are
Visually Impaired/Blind” and “Accessibility Tips for Web Page
Developers.”

Mindy Brown, Vicki Lauck, and Isabel Castro
presented a session entitled, “Uses of Technology to
Encourage Language and Literacy in Blind
Children.” Many students with communication,
physical, or visual impairments cannot take tests
using traditional methods. The quiz feature of
IntelliPics offers testing solutions to students with a
variety of disabilities. For example, a totally blind
student can use IntelliPics software and the
IntelliKeys keyboard to take a quiz using a multiple-
choice format. A teacher can test this student on his
knowledge of animals by creating an IntelliPics quiz.
The student answers the questions (e.g., Where is the
cat, the dog, the horse, the pig, the cow?) by
choosing one of the five animal pictures using
IntelliKeys.

The instructions in this article are designed for
persons who have knowledge and experience with
the IntelliTools programs. The names of buttons,
menu items, or commands appear in bold; the text to
be entered by the programmer appears in
“quotations.” Do not type the quotation marks (“”).

Follow these steps to create an IntelliPics activity and
overlay. A detailed tutorial for Overlay Maker and
IntelliPics can be downloaded from the ATEN web
site (www.aten.ocps.k12.fl.us).

1. Create an IntelliPics activity for the quiz with 
desired picture items (e.g., five farm animals).

2. From the File pull-down menu, select Make 
Overlay.

3. Save the IntelliPics overlay.

4. Open the overlay and adjust the size of the 
picture squares to create one row of five symbols.

5. Create a second row of empty squares (without 
key content) as place holders for the tactile 
symbols. (See Diagram A.)

I created a Thanksgiving activity and quiz by using
the the following picture items: pilgrim, turkey,
cornucopia, Native American, and pumpkin. I made
a 2-row by 5-column overlay with squares large
enough to fill the entire page. I placed the squares
that sent the answers (e.g., “turkey”) to the
IntelliPics program in the top row. For students with
visual impairments, I placed the tactile squares in
the bottom row where the student could feel the
symbols without sending anything to the IntelliPics
program. 

For students who use their vision, I placed large
pictures in the squares in the top row. After printing
the overlay, I outlined the squares in the top row
with raised fabric paint. I placed miniatures of the
picture items (that I found at craft stores or created
with quick-set clay) on the tactile squares in the
bottom row.

Follow these steps to create the quiz:

1. Open the IntelliPics activity created for the quiz. 
From the Create pull-down menu, select 
Quizzes.

2. Select New. Type in a name for the quiz (e.g., 
“Animal Quiz”) and press the Return key.

(continued on page 5)

Gap Capsules 

by Donna Kazee

Diagram A

Making Accessible Quizzes
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(continued from page 4)

3. In the box next to Answer(s), type “[picture]”. 
(The computer inserts the name of the picture in 
place of [right].)

4. From the Sound for pull-down menu, select 
Initial Question and type “Where’s the [right]” 
in the If synthesized box. (The computer inserts 
the name of the quiz answer in place of [right] 
and speaks the prompt.) Click on Play to 
preview the prompt.

5. Depending on the visual ability of the student, 
either leave the Prompt item box blank or type 
“[right]” to have the program flash a visual 
prompt for the picture item.

6. From the Sound for pull-down menu, select 
Correct Response and type “Great! You found 
the [right].”

7. From the Sound for pull-down menu, select 
Incorrect Response 1 and type “Try again.” 

8. From the Sound for pull-down menu, select 
Incorrect Response 2 and type “Sorry, try 
again.” 

9. From the Sound for pull-down menu, select 
Incorrect Response 3 and type “Look Closer.” 

10. From the Sound for pull-down menu, select 
Incorrect Response 4 and type “Ask someone 
for help.” 

11. Quit the quiz creation mode by selecting Done,
then select Done again.

12. If you have not already specified a spoken name 
for the picture items to be used in the quiz, from 
the Create pull-down menu, select Picture Item.
Click Edit, then click Advanced, and then click 
Spoken Name. Type in the name and click Done
until you are out of the picture item windows 
and back to the activity.

13. From the Play pull-down menu, select Play 
Quiz. Double-click the quiz you created and use 
the IntelliKeys to answer the questions.

Spotlight on Ridgeview Elementary
(continued from page 3)

her wheelchair and “look” out the window all day.
On her first day with us, we asked her if she wanted
to get out of her wheelchair. We put a large Yes/No
board in her lap and put her hand (repeatedly) on
each side, telling her, “This is Yes;” and “This is No.”
She slowly raised her arm in the air and dropped it
down on the “Yes” side. Within one week, she was
making a choice for music and selecting between
two tapes. Whenever she heard the music she chose,
she lit up with a big smile and “hummed” along.
From nothing to all this in one week! 

As self-esteem increases, appropriate behavior
increases and inappropriate behavior decreases. We
also have seen an increase in head control, attention
to task, and increased desire to communicate. We
have even seen students begin to toilet train.
Students now have communication skills that can
travel with them wherever they go. A mother can
grab a napkin in a restaurant, write down meal
choices, and her child can communicate what she
wants to eat.

Finally, and most importantly, every person
deserves to be treated with the utmost dignity.
When we work with our students using a literacy-
based program, we are treating them as intelligent
human beings. It not only increases self-esteem, but
it also influences how they are viewed by others. It
thrills us to see the amazing progress made. But
even if there was little or no progress, it would still
be worth it because we have treated our students
with dignity!

Thank you to the following people 
whose photos appear in the 1998 
ATEN calendar:

Sarah Mallette Cody McDowell
Alexis Rogers Devona Hardrick
Philip Wickman Jennifer Jay
Jacquelyn Flowers Oliver Love
Jimmy LoPorto Susan Koeppen
Miranda McCune Barbie Freeman
Kenneth Sapp

1998 ATEN Calendar
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Editor’s Note:  The Winter 1996 issue of the Keyhole
Communiqué featured Denise Lance and her story titled,
“My Webbed Feet: Confessions of an Internet Addict.”
Denise acquired cerebral palsy (CP) at birth and uses her
feet as most use their hands. Questions may be addressed
to Denise through e-mail at detommd@mail.firn.edu or by
calling ATEN at (800) 328-3678.

What comments do you hear from strangers and
people you know regarding your disability that
frustrate you the most?
What frustrates me the most is when strangers say
things to me that indicate they think I am mentally
retarded. I want to say, “Guess what? I’m getting a
Ph.D. I don’t have an intellectual impairment. Even
if I did, I would deserve your respect as a human
being! If you had a daughter, sister, or aunt with
cerebral palsy, would you want people to speak to
her like you were speaking to me?” I don’t mind
children’s comments. They are just curious. But I
think adults should know better!

The part of my disability which bothers people the
most is my drooling. I understand that it is not the
most attractive thing. Barbie and Miss America don’t
drool.  A few months ago, my mother and I were out
at a casino playing slot machines. When the waiter
stopped by, even before he asked what we would
like to drink, he asked Mom if I needed a napkin or
something.  Mom just said, “No, she’s fine. Thanks.”
I felt as if all that waiter saw was one big drooling
mouth!

My family members are always reminding me to
wipe my chin with the sports wrist band I always
wear. I sometimes tire of hearing this, but I know
they are just trying to save me from unkind
comments and stares.

Many people in the disabled community take
offense when people use outdated or misguided
language (not politically correct). What are your
feelings about this?
I grew up in the age before political correctness and
attended a preschool named, The Crippled Children’s
Nursery School. “Crippled” is the one label of which I
am least tolerant. I’m an advocate for disability

issues but not an
extreme radical. I prefer
people first, label
second (e.g., individuals
with disabilities, person
who has disabilities,
student with cerebral
palsy.) However, if I
catch someone saying
“handicapped person”
or “LD kid,” I don’t
attempt to wash their
mouths out with soap.
At times, even I have to
make a conscious effort
to be politically correct.
I catch myself
describing someone as
“autistic” rather than
“having autism.” So, I cut people some slack. 

I have noticed that the local television news
reporters have not gotten the message yet. They
often have stories about “the disabled” or “the
mentally handicapped.” I think they are trying to
save words, but I know many special education
professors who would give a paper a failing grade
that used those same terms. I also wish the
Handicapped Parking signs were changed to Parking
for Disabilities—It’s just one more word!

Who are the real decision makers regarding
assistive technology?
This depends to some extent upon the age of the
person needing assistive technology. Early childhood
and elementary students are often at the mercy of
the assessment teams choosing their devices.
Secondary students may have slightly more input,
and adults even more. Of course, a person of any
age can demonstrate his or her opinion about a
device by either using it or abandoning it. Sadly, it is
when users abandon or refuse to use assistive
technology that some teams realize that they should 
have consulted the student from the beginning of the 
assessment process. Currently, I think the ultimate
decision makers in many cases are those that
approve or deny funding. (continued on page 7)

Go Ahead, Ask Me!
by Denise Lance
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When I was five my classroom got a new Apple II,
not a IIe or even a IIc. It was an Apple II. I think the
first program I liked was “Hop-a-long Cassidy.” I
forget what it did, but I liked it. Then there was
“Hodge Podge”—when you pressed a key a picture
would come up. When I was ten years old, I learned
a few basics and started to write little programs. I
drew an ice cream truck with some music playing in
the background. 

When I moved to a new house, the people in the
Sarasota School System gave me an Apple IIe, which
I ran into the ground. A couple of years ago I bought
a MacIntosh Performa which was supposed to last at
least until the millennium. Now, unfortunately, it
doesn’t look like that will be true. The modem isn’t
fast enough, the memory isn’t big enough, it keeps
crashing, and it doesn’t have a good enough printer.
If that wasn’t enough, I’ve discovered that if you
own a MacIntosh, the world treats you differently. In
the two years I’ve owned my MacIntosh, I’ve
experienced more discrimination from owning a
Mac than I ever did from being disabled. A prime
example is the Tampa Bay Devilray website where
you can take a virtual tour of Tropicana Field—only
if you own an IBM compatible computer! SORRY
ALL MAC USERS! When I think of everything I owe
to Steve Jobs, it breaks my heart to think this might
be the last Apple computer I will ever use. It’s like
watching a friend sink in quicksand.

Thoughts by Seth

by Seth Taylor

(continued from page 6)

What and how much input did you have in the
process of selecting your assistive technology?
I was very involved in finding the assistive
technology I use, mainly because the professionals I
consulted did not find assistive technology which
met my needs. I was the one who finally decided
that abbreviation expansion was what I needed.
(Editor’s note: Abbreviation expansion provides for the
transmission of a message with a reduced number of
keystrokes.)

When did you learn about assistive technology?
I first heard about high tech assistive technology in
high school and began reading about assistive
technology during my first few years of college. It
was not until the end of my sophomore year that I
received my first computer and began to research
access methods. I have an essay about this process
on my web page:

http://toetype.home.ml.org/cogs.html

An Old Friend in Trouble

IDEA Reauthorized

After two long years of debates and compromises,
IDEA was reauthorized by Congress in May 1997
and was signed by President Clinton on June 4. The
right of a student with disabilities to a “free and
appropriate public education” has been maintained
in this bill. In addition, IDEA ‘97:
• includes provisions that schools must include 

students with disabilities in assessments with 
appropriate modifications, and that states must 
develop alternate assessments for the small 
number of students who cannot take regular 
assessments. 

• requires that transition planning begin no later 
than age 14 and that a student’s transition plan 
focus on the course of study the student will 
pursue in high school.

• requires that specific considerations be made for 
certain groups of children with disabilities. IEP
teams must consider, for example, communication
needs of children and the use of assistive 
technology for those who require it.

• states that parents be included in groups making 
eligibility and placement decisions about their 
children with disabilities in addition to the right to
be included at IEP meetings.
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Bright Ideas

In the Fall 1997 issue of the Keyhole Communique, I discussed
information from a workshop I attended called, “It’s A Balancing
Act!! Integrating Technology and Literacy in Elementary
Schools.” The workshop was conducted by Dr. Karen Erickson
from the Center for Literacy and Disability Studies, Duke
University, and Dr. Caroline Ramsey Musselwhite from Special
Communications. This article will continue to explore the Four
Block method for Literacy by reviewing some of the steps
involved in Guided Reading. 

Guided Reading Activities
Guided reading is intended to help students learn
that reading involves thinking and comprehending
text. With beginning readers, guided reading
includes introducing the book’s concept and then
reading the book to the students. The students read
along with the teacher the second time and fill in
predictable and repeated text. After the first few
readings, the teacher conducts activities to reinforce
the words and concepts of the story.

Five Steps to Teaching Reading Comprehension 
As students’ reading skills improve, lessons begin to
focus on providing direct instruction in reading
comprehension. These strategies are taught using
this five-step approach:
1. Build or activate a background knowledge.
2. Set a purpose for reading a selection.
3. Read the selection alone or with a partner.
4. Complete a group task directly related to the 

purpose.
5. Provide informative feedback on completion of 

the task.

Selecting Guided Reading Materials
Select reading materials from a variety of sources
(e.g., stories from basal readers, sections from subject
area books, and/or magazines). When choosing
reading materials, alternate the reading difficulty
level from grade level (or whatever the average
reader in your class can handle) to below grade level
books. If several students have difficulty
understanding a passage, reread it for different
comprehension purposes.

Including Students With Disabilities
Including students with disabilities in the guided
reading process involves some planning and
preparation. Provide students with opportunities for
interaction with printed materials, assure access to
books, and provide a method for students to relate
the story to prior knowledge and experience.

Promoting Literacy Through Symbol Use
The idea of a print-rich environment has been
promoted by many experts in the field of AAC to
increase literacy opportunities for students with
disabilities. Symbols with the printed word attached
promote literacy and provide a means for students to
communicate information about what they are
reading. They can describe what is happening in a
story, what the characters are doing, and where
things are located. At a prereading stage, students
can point to symbols to label and match pictures.

Reading materials can be adapted in the following
ways:
• Create a story-specific communication display. Use

symbols to represent the main concepts from a 
story (e.g., for Goldilocks and the Three Bears, use 
the following symbols: bed, chair, porridge, Baby 
Bear, Mama Bear, and Papa Bear) and include 
phrases (e.g., Let’s read a book, My turn, and Read
it again). (continued on page 9)

Guided Reading: Following the Path to Comprehension

Read a story. My turn. Read it again.

porridgechairbed

Papa Bear Mama Bear Baby Bear

by Dianne Mathews
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ATEN will be facilitating a custom
administration of the

RESNA
Credentialing
Examination

to be held in Orlando on the morning
of Monday, June 1, 1998.

In order to administer the exam,
RESNA requires a minimum of 25

registered participants. Applications
may be downloaded from the RESNA

web site (www.resna.org).

The deadline for registration is 
April 27, 1998. Forms must be

received at the RESNA office by this
date.

RESNA
ATTN: Credentialing Program

1700 North Moore Street
Suite 1540

Arlington, VA 22209-1903
703-524-6686

(continued from page 8)

• Use a symbol to represent the repetitive line from 
a story (e.g. “But he was still hungry!” from the 
book, The Very Hungry Caterpillar by Eric Carle).

• Create removable symbols for matching pictures 
in storybooks (e.g, for Big Dog and Little Dog by 
Dav Pilkey, use symbols for concepts such as 
adjective: big, little; nouns: dog, food; and verbs: 
sleep, eat).

Promoting Literacy Through the Use of Voice
Output

Opportunities to actively participate in a variety of
literacy activities can be provided to students with
disabilities by using voice output devices.

•Record a repetitive line from a book into a single-
message, voice output device (e.g., BigMack, Mini
Talking Card Reader, a talking picture frame, a tape
recorder with a continuous loop tape, etc.).

•Use a short, children’s book (with two to three lines
on each page). Record each page into a message area
on a voice output device (e.g., Hawk, AlphaTalker,
Macaw, etc.).

For more information on literacy and technology for
students with disabilities, write to

The Center for Literacy and Disabilities Studies
Department of Surgery 
Duke University Medical Center
Box 3108
Durham, NC 27710 

But he was still
hungry!

big

little
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Book Reviews

Children with Visual Impairments: 
A Parents’ Guide
M. Cay Holbrook, Editor
Bethesda, MD: Woodbine House, Inc.
Price: $16.95
ISBN: 0-933149-36-0
This guide is designed for use by parents who have children
with mild to severe visual impairments. The following topics
are covered: diagnosis and treatment, family and life
adjustment, child development, early intervention and
special education, literacy, orientation and mobility, multiple
and visual disabilities, legal issues, and future concerns and
expectations. Additional resources such as lists of organizations, school, publications, and a glossary are
provided at the end of the book. 

The New Language of Toys
Teaching Communication Skills to Children with Special Needs: 
A Guide for Parents and Teachers
Sue Schwartz and Joan E. Heller Miller
Bethesda, MD: Woodbine House, Inc., 1996
Price: $16.95
ISBN: 0-933149-73-5
The activities and toy dialogues in this book help parents and teachers use a hands-on approach to help
stimulate language development in children with special needs from birth through age six. Chapters focus
on language development in children, activities to help children learn and be creative, toy dialogues to help
teach language in a variety of ways, computer technology, and toy safety. The appendices include a resource
guide, toy manufacturers directory, and a materials list.

Technology in Early Intervention
James A. Blackman, Editor
Gaithersburg, MD: Aspen Publishers, Inc., 1995
Price: $29.00
ISBN: 0-8342-0649-8
This softcover book is the third in the Infants & Young Children Series and is a great resource for all
professionals who work with infants, children, and their families. Topics covered in this book include
technology intervention for very young children with disabilities, early intervention for technology-
dependent infants and young children, effective inclusion of technology into developmental plans, and safe
transportation for infants and preschoolers with special needs.

by Kathleen Bastedo
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Technofile
by Anne Banton

Freestyle

The Freestyle is a full-featured Macintosh computer housed in a sturdy case. It has a 750 MB hard drive with
16 MB RAM (upgradable to 64 MB) and a 100 MHz Power PC
603e chip. Built-in features include: a touch screen, switch
jacks (for up to four switches), printer/modem port, sound
input jack, SCSI port, PCMCIA card slot, ADB port, infrared
capability for X10 modules, built-in microphone and
microphone port, and 12X CD-ROM drive. A jacket protects
the Freestyle when closed and can be used to create a wedge
or reading stand for the device. Optional accessories include a
carrying case with an adjustable strap, a wheelchair mount,
and an adapter so the device can be powered from a
wheelchair battery. The Freestyle weighs 6.4 pounds and is
11.5”w x 9.75”h x 1.875” in depth.

Mac OS version 7.5.3. Rev2 system and Companion software come installed in the Freestyle. The Companion
software is an authoring tool for creating interactive computer applications. It allows an individual to create
screens using graphics and sound (e.g., creating buttons to open applications, developing picture menus,
accessing environmental controls through picture cues, and using the on-screen keyboard to type). It has the
ability to combine graphics, text-to-speech (MacinTalk) or digitized speech, sound labeling, and QuickTime
movies. Other software can be accessed through the CD-ROM or installed on the hard drive through the use
of an external floppy disk drive. The manufacturer recommends attaching an external keyboard and mouse
to install software. 

The Freestyle is available for $5,495 from:
Assistive Technology, Inc.
850 Boylston Street
Chestnut Hill, MA 02167
800-793-9227
www.assistivetech.com

Macintosh Computer 

Synergy produces a Macintosh computer similar to the Freestyle which can be customized with a variety of
access options (e.g., single switch, Touch Screen, HeadMouse). When ordering a computer from Synergy, the
buyer must specify which options they want included.

The Macintosh computer is available for $4,995 (base price) from:
Synergy
412 High Plain Street 
Suite 19
Walpole, MA 02081
508-668-7424
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Mark Your Calendar
March 5-7, 1998, Florida Educational Technology
Conference, Orlando, FL
Contact: Florida Educational Technology
Corporation, P.O. Box 13468, Tallahassee, FL
32317-3468, (850) 894-3810
http://www.fetc.org

March 17-21, 1998, CSUN 13th Annual Conference,
“Technology and Persons with Disabilities,”
Northridge, CA
Contact: CSUN, Center on Disabilities, California
State University, Northridge, 1811 Hordhoff Street,
Northridge, CA 91330-8340
http://www.csun.edu/cod/

April 2-3, 1998, Meeting the Needs of Infants and
Young Children In the Family and Community,
“Triumphs and Challenges,” Sarasota, FL
Contact: Early Intervention Program (941) 917-7550
or (800) SMH-Talk, X7550

May 21-24, 1998, FLASHA, Marco Island, FL
Contact: Melanie Howe, FLASHA Office, 
(800) 243-3574

June 26-July 1, 1998, RESNA ‘98, “The State of the
Arts and Science,” Minneapolis, MN
Contact: RESNA, 1700 N. Moore Street, Suite 1540,
Arlington, VA 22209-1903, (703) 524-6686

October 20-21 (pre-conference)
October 22-24, 1998, Closing the Gap,
Minneapolis, MN
Contact: Closing the Gap, P.O. Box 68, Henderson,
MN 56044, (507) 248-3294
http://www.closingthegap.com

Visit ATEN on the web at www.aten.ocps.k12.fl.us
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Try This On For Size
by Mark Sardo

3.To change the desktop font type:
From the Font for view pull-down menu, select 
a font type.

4.Click the Close box of the Views control panel 
window.

Folder/Icon Sizes

Mac OS 8.0 and later:
1.To change the size of the desktop icons:

a.Click on the desktop, to make the Finder 
menu active.

b.From the View pull-down menu, select View 
Options.

c.Next to Icon Size, click on the radio button 
to select a size.

d.Click OK.
4.To change the size of a folder icon

a.Open a folder.
b.From the View pull-down menu, select View 
Options.
c.Next to Icon Size, click on the radio button to 
select a folder size.
d.Click OK.

Mac OS 7.6.1 and previous:
1.From the Apple pull-down menu, highlight 

Control Panels, then select Views.
2.To change the List View size of the icons:

Under List Views, click on the radio button to 
select a size.

3.To change the icon spacing:
Under Icon Views, click the Straight grid radio 
button. (Straight grid only impacts windows 
being viewed in the ‘by Icon’ format.)

4.Click the Close box of the Views control panel 
window.

Editor’s Note: Refer to the Spring 1997 issue of the Keyhole
Communiqué (pages 4-6) for information on customizing
Windows 95.

The following information is a summary of
suggestions for customizing the Macintosh OS so
that it may be used more effectively by individuals
with visual impairments. (Choose the changes
appropriate for each student.) 

Desktop Fonts, Sizes, and Icon Spacing

Mac OS 8.0 and later:
1.From the Edit pull-down menu, select 

Preferences.
2.To increase the size of the desktop font:

From the size pull-down menu, select the point 
size of the font. (For 15” monitors and smaller,
use 14. For 17” monitors and larger, use 14–18.) 

3.To change the desktop font type:
From the Font for view pull-down menu, select 
a font type. [A sans serif font (e.g., Geneva), 
one without curls at letter ends, is easier to 
read on a computer screen.] 

4.To increase the space between the desktop icons:
Click on the Wide radio button, next to Grid 
Spacing.

5.Click the Close box of the Preferences window.

Mac OS 7.6.1 and previous:
1.From the Apple pull-down menu, highlight 

Control Panels, then select Views.
2.To increase the size of the desktop font:

From the font size pull-down menu, select the 
point size of the font.

Common Computer Terms

Operating System: the software of a computer that allows the user to direct the hardware to execute a
particular function, e.g., allows the user to open, save, close, and print files. Examples of operating systems
are the Macintosh OS, Windows 95, and Windows 3.1.

Control Panel: a software program that is part of the operating system that provides the means to make a
change in the system, e.g., the Views control panel of the Macintosh OS and the Display control panel of
Windows 95 are where the font size of desktop icons is adjusted.

Desktop: the “area” of the computer that contains icons and menus for opening/manipulating files, folders,
and applications.


